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Introduction 
 
Congratulations on your purchase of SentryPlus Shutdown Management Software to manage your 
Uninterruptible Power Supply (UPS). The goal of SentryPlus is to monitor your UPS and take care of 
all your power management needs. SentryPlus has the ability to properly shutdown your computer 
when an extended power outage occurs. 
 
SentryPlus provides the most useful information about the UPS and all of your power management 
inquiries. We added the most popular network management protocol (SNMP) into SentryPlus, Sen-
tryPlus will translate UPS information into SNMP MIB to the appropriate Network Management 
Station (NMS) such as HP OpenView. To make use of resources on the Internet, SentryPlus also 
supports HTTP protocol. That means you can monitor your UPS anywhere, anytime just using the 
Internet browser. 
 
SentryPlus runs in the background as a daemon process on UNIX systems, and communicates to 
the UPS to keep your computer and equipment protected from any power problems. Furthermore, it 
gives you the most useful information about your UPS and computer. 
 
SentryPlus features: 
1.Graceful operating system shutdown  
2.Schedule test, shutdown/restart UPS, turn on/off receptacles  
3.Flexible events  
4.Notification: Pager, e-mail and audible alarm, network broadcasting and SNMP  
5.Real-time values of voltage, current, frequency and loading 
6.History data & graph  
7.Network monitor  
8.Multi-computer shutdown/restart  
9.Support Simple Network Management Protocol (SNMP)  
10.Support HTTP, remote monitor and control using Internet browser 
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SentryPlus Installation 
 
System Requirements: 
1. To use SentryPlus your system must be running one of the following operating systems: 
z Hewlett Packard HP-UX 10.0 (SentryPlus Service Only) 
z IBM AIX 4.3 
z SCO OpenServer 5.0 
z SunSoft Solaris 2.5.1 for SPARC processors 
z RedHat Linux 5.2, Turbo Linux 4.0, SUSE Linux 6.1, Open Linux 2.3, Mandriva Linux. 
z FreeBSD 2.2.8 

2. SentryPlus Monitor can run on X11R6 or above with 256 or more colors. 
 
SentryPlus Setup: 
1. To setup SentryPlus, please login to your system as supervisor (root). 
2. Place the SentryPlus CD in your CD-ROM drive and mount it.  
3. Change the working directory to /CD-Rom/Unix/YourUnix, where /CD-Rom is the mount point of 

your CD-ROM drive, and YouUnix is the name of your Unix System. For example, 
/cdrom/Unix/Linux or /cdrom/Unix/Sun. 

4. Copy the only one file, YourUnix.tar, in your working directory to directory /tmp. 
5. Change your working directory to /tmp. 
6. Tar the file with the command: tar xvf YourUnix.tar. Note that some OS may require “-“ before ar-

guments. 
7. Run/install. 
8. Follow the instructions from the install program. 
9. After installation, SentryPlus program files will be located in the directory /usr/local/smart. 
Notice: Some OS may not activate COM port as default. Thus, make sure the COM port connects to 
UPS has been activated before running SentryPlus. 
The SentryPlus software is comprised of two modules: 
z A UPS Monitoring Module (SentryPlus Service, file name: upsd), that runs in the background as 

a daemon process on your system and communicates to the UPS.  
z A User Interface Module (SentryPlus Monitor, file name: monitor) that enables you to control 

and configure SentryPlus through the drop down menus and dialog boxes. It also allows you to 
monitor the UPS through the Main Screen.  
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SentryPlus Service 
 
SentryPlus Service, which runs in the background, is a daemon process when the system starts up. 
You can also run SentryPlus Service manually by typing the command /usr/local/smart/upsd. To stop 
SentryPlus Service, type the command /usr/local/smart/upsd stop. 
 
 
SentryPlus Monitor 
 
SentryPlus Monitor enables you to control and configure SentryPlus through the drop down menu 
and dialog boxes. It also allows you to monitor the UPS through the Main Screen. SentryPlus Moni-
tor does not need to reside in the memory the execution depends on the user's requirement. This 
can save precious system resources for you. 
After finishing the SentryPlus installation, SentryPlus Service automatic loads into memory and runs 
once the operating system starts up.  
To run the SentryPlus Monitor, change your working directory to /usr/local/smart and type the com-
mand /usr/local/smart/monitor.  
 

SentryPlus Monitor Main Screen: 
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Networking 
 
SentryPlus software is comprised of two modules: SentryPlus Service and SentryPlus Monitor. You 
may run both the programs to monitor your localized UPS or run the programs on two different com-
puters. 

Multi-Computer Shutdown. 
SentryPlus Service with 2 modes: Master and Slave.  
 
 
 
 
 
 
 
 
If there is a communication cable between the computer and a UPS, this computer called Master. 
The Master can monitor and control the connected UPS directly, as it also transmits the UPS infor-
mation to the Slave(s). 
If a computer does not connect to the UPS directly but is powered by the same UPS, this computer 
called the Slave. Master communicates to Slave via a TCP/IP network. 

 
 
 
 
 
 
 

When a power event occurs, Master (SentryPlus Service) gets the information and then transmits it 
to the Slave(s) (SentryPlus Service). Each SentryPlus Service executes different "Actions" 
(FlexEvent) such that the system manager can configure a different strategy to a different computer. 
For example: When power fails, file server and mail server will not shutdown until the UPS battery is 
low but some unimportant workstations execute shutdown OS after 5-minutes and the other worksta-
tions shutdown after 10-minutes. Shutdown workstations preserve more battery power for network 
servers. 
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Remote Monitor And Control 
 

Remote Monitor and Control: SentryPlus Monitor. 
SentryPlus Monitor has the ability to monitor Local host and Remote host.  

 

 

 

 

 

You can run SentryPlus Monitor without running SentryPlus Service, SentryPlus Monitor will search hosts in 
the LAN (Local Area Network) that runs SentryPlus Service in the combo box. Click on the Host Selection 
combo box and it will provide a list of the searched hosts in the LAN. Select one, then SentryPlus Monitor will 
connect to the selected host. The host is located on the Internet so you can also input the remote host IP ad-
dress from the View – Remote Hosts menu to establish the connection. 

 

 

 

 

 

 

 

 

 

 

 

Remote Monitor and Control: Internet Browser. 
Another way to remote monitor SentryPlus Service is by using the Internet Browser. Launch the Microsoft 
Internet Explorer or Netscape Communicator, type the IP address in the URL and press enter you will get the 
UPS information. You can change the network port number to prevent conflict with other WEB server pro-
grams. If the port number is not 80 you have to type URL like this: http://172.16.176.141:2000 where 2000 is 
the port number you assigned. The default User Name and Password is admin. 
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SentryPlus Monitor Operation 
 
The Main Screen has 7 areas that present information on the operating status of your UPS. These 
areas are discussed in the following sections. 
 
 
 
 
 
 
 
 
 
 
 
 

Host Selection: Press the combo box to select hosts that runs SentryPlus Service in the LAN. Users 
can monitor or control (need password) remote UPS.  

Connection Indication: The sine wave will appear while the communication between SentryPlus 
Monitor and SentryPlus Service is established.  

Information Display: Press Bottom Layer Buttons to change the information that is displayed in this 
area.  

Recent Event Log: Shows the last 10 event logs in the combo box, click on the combo box to pull 
down and see the logs.  
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Top Layer Buttons 
 

Top Layer Buttons 
Use these buttons to speed up your operation. Refer to the dialog boxes in the menu. 
 
 
 
Configuration: Same as the System-> Configuration in the menu.  
Meters: Same as the View-> Meters in the menu.  
Event Log: Same as the View-> Event Log in the menu.  
History Graph: Same as the View-> History Graph in the menu. 
 
SentryPlus Monitor Main Menu 
The Main Screen has a menu bar at the top with 4 main options: 
System: This menu allows you to set the SentryPlus and computer parameters.  
Control: This menu allows you to set UPS buzzer, outlet, and test.  
View: The View menu allows you to see the real-time values and history event or history data.  
Help: The Help menu allows you to access the online help system. 
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System Menu 
 
The system menu allows you to configure the UPS and monitor screen parameters. When you select 
the System menu from Main Menu bar, a drop down menu appears offering you the following menu 
options: 
Login: Used for Remote Monitor. User must pass the password verification before they can control 
or configure the UPS.  
Configuration: The Configuration menu allows you to tailor various SentryPlus parameters.  
Monitor Screen: Allows you to change display items in the Scroll screen of Information Display Area. 
Window: This menu allows you to change the display items in the Information Display Area. The 
items in the menu refer to each button in the Bottom Layer Buttons.  
Close Monitor: Stop SentryPlus Monitor. 
 
Login 
When SentryPlus Monitor becomes a Remote Monitor (connect to different host) you have to pass 
the password verification if you want to do configuration or control the UPS, otherwise, you can only 
view the UPS information. 
 
If the user runs SentryPlus Service and SentryPlus Monitor in the same computer, you can do your 
configuration or control the UPS without a password. 
To change your password, please choose the Set Password from the Configure - Network menu. 
 
Monitor Screen 
This dialog box allows you to change display item in the Scroll screen of Information Display Area. 
 

a. Meters: Press the Main button in the Bottom Layer Buttons there 
are two meters in the information area. You can change the display 
items of the two meters.  
b. Scroll Window: Press the Scroll button in the Bottom Layer But-
tons, the scroll window display in the information area. This item 
allows you to change the display step and items. 

 
 

 
Window 
This menu allows you to change the display items in the Information Display Area. The items in the 
menu refer to each button in the Bottom Layer Buttons. 
 

Close Monitor 
Close SentryPlus Monitor and leave SentryPlus Service running. 
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Configuration Window 
 
The Configuration Screen has a menu bar at the top with three main options: 
Devices: This menu allows you to configure modem, pager and e-mail.  
UPS: The UPS menu allows you to plan the UPS schedule or do the Action. 
Network: This menu allows you to choose Master/Slave or configure SNMP, HTTP functions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Configuration Window 
UPS Communication Port: COM1, ... COM4.  Port names are different from systems. 
Next UPS Test Date/Time: The date of the next user-initiated UPS self test. Setting from System-
>Configuration->UPS->Schedule.  
Next UPS Shutdown Date/Time: This field display the date of the next shutdown for the computer 
and UPS. Setting from System->Configuration->UPS->Schedule.  
Next UPS Restart Date/Time: The date of the next restart UPS. Setting from System-
>Configuration->UPS->Schedule.  
Local Host IP: IP address of a computer, that runs SentryPlus Monitor.  
SentryPlus Service Mode: SentryPlus Service acts as a Master or Slave.  
Remote Host IP: The host, that runs SentryPlus Service. If SentryPlus Monitor and SentryPlus Ser-
vice run on the same computer this field will be empty. 
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Devices Menu 
 

Devices  
Modem: To let SentryPlus notify you via pager, you must setup the modem device. SentryPlus will 
control the modem device using AT Command as default. 

 

a. COM Port: The communication port COM1, ...COM4.  
b. Baud Rate: Define the data transmitting speed.  
c. Initialize String: The string that is sent to the modem be-
fore paging is attempted.  
d. Dial Prefix: The string that added to the beginning of each 
of the Pager Number before they are sent to the modem.  
 
 

 
Notification Users: Pager List 
 

Notification Users -- Pager List: The program will dial the modem to notify all of the pager number 
that are listed on the pager list. You can input your pager number by yourself. For example if, 
060123456 is your pager number, each ',' tells modem to delay 2 seconds, the delay time is for wait-
ing the response signal from switching then transmit the display number 119. 119 will appear on your 
pager LCD. To trigger the pager notification you must enable the Pager Action in the Action dialog 
box.  
 

a. Add: Add a new pager number.  

b. Modify: Modify the selected pager number.  

c. Delete: Delete the selected pager number.  
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Notification Users: E-Mail 
 

Notification Users -- E-Mail: You can also e-mail information to users through SMTP when power 
event occurs. The program calls the send-mail command to transmit information to the assigned e-
mail users. 
To trigger the e-mail notification you must enable the e-mail Action in the Action dialog box.  
 

a. Add: Add a new user.  
b. Modify: Modify the selected user name.  
c. Delete: Delete the selected user. 
d. SMTP: Configure your SMTP server to send the e-mail. 
 
 
 
 
 

 
 
 
Notification Users: Network Broadcast 
 
Notification Users -- Network Broadcast: You can also broadcast information to users when 
power event occurs. To trigger the broadcasting notification you must enable the Broadcast Action in 
the Action dialog box.  
 

a. Domain: Enable this item to broadcast all the users in the 
domain, otherwise SentryPlus will send messages to the 
hosts that user assigned.  
b. Add: Add a new machine name.  
c. Modify: Modify the selected machine name.  
d. Delete: Delete the selected name.  
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UPS Menu 
 
UPS Property: This dialog box allows you to configure the UPS COM port, battery replacement date, 
etc. Load Warning and Load Severity are used to prevent UPS overload (see the UPS hardware 
user's manual). Load Warning will notify the user to reduce the load of the UPS. Load Severity will 
shutdown the computer to prevent overload.  
 

a. COM Port: COM1, ...COM4.  
b. Load Warning: Load warning.  
c. Load Severity: User must reduce UPS loading.  
d. Last Battery Replacement Date: Record last 

battery replacement date.  
e. Next Battery Replacement Date: The date of 

next battery replacement, SentryPlus will notify 
user to replace the battery.  

f. Host Name: Local host name.  
 
 
 

 
Attached Devices: Assign the attached device name. When you are controlling the outlet, Sentry-
Plus will let you know which devices you are controlling.  

a. Select an Outlet Group: Assign an outlet group. Please see the back panel for some outlets 
may share one control relay, these outlets are called the outlet group. If you turn off outlet 
group1 (for example: outlet1 and outlet2) then the UPS will stop power output to outlet1 and out-
let2.  

b. Device Name: Assign the attached device names, for example: Outlet Group1 is for printer; 
Outlet Group2 is for computer. These records can improve the efficiency of your management. 
Don't forget to press the Update button.  

c. Update: Update your change.  
 

Log Management: (Please consider the free space in your hard disk)  
a. Maximun Event Log Entries: SentryPlus saves less than the assigned entries of the event log.  
b. Data Log Interval: Time to save a record of UPS data.  
c. Maximun Data Log Storage: It allows you to save how many months of UPS data files.  
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Schedule 
 
Schedule: This function allows you to shutdown, restart, test and turn on/off outlet. You can sched-
ule up to 6 events. Setting is based on day, week or month and up to a period of 2 years. Choose 
the applicable schedule to set whether it is for:  

 
a. One Time: This set schedule is applicable 
for a single day.  
b. Daily: This set schedule is applicable for 
every day  
c. Weekly: This set schedule is applicable for 
once a week period.  
d. Monthly: This set schedule is applicable for 
once a month period.  
 
 
 
 
 
 
 
 

 
 

Action 
 
Action: The action menu provides you with a list of events to choose from. The event and/or any 
combination of these actions can be selected from the Choose Event list box. Actions that are al-
ready enabled will show a check mark. To delay the actions, set the desired time for delay in the 
Delay combo box.  

 
a. Choose Event: When you select one item in the list 

the action buttons will display current setting. Press 
button to do further configuration.  

b. Set Default: Set all the actions to default values.  
c. Delay: The power event must stay the delay time to 

trigger actions.  
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All the actions are described as follows: 
 
Action - Shutdown: Shutdown/Hibernate/Suspend the operating system or shutdown the UPS. Both 
Hibernate/Suspend are available only on MS Windows. If you select the shutdown item, SentryPlus 
will execute or ignore the Auto-Save function depending on your selection (in the Action dialog box). 
But if you select suspend or the hibernate item; the program will ignore the Auto-Save function. The 
functions of shutdown or hibernate or suspend are the same as if you select the Shutdown from 
Windows Start menu.  
 
Action - Logging: Permits you to log event as well as modify the default-logging message. You can 
see this message in the Event Log dialog box.  
 
Action - Broadcasting: Permits you to broadcast an event based on a set period of time. If you 
want to be notified once, set the time period to "0". However, if you want to be notified more than 
once, set the time period to a larger number. Each number corresponds to the times of notification.  
 
Action - Paging: Permits you to set the time period of paging intervals. If you want to be notified 
once, set the time period to "0". However, if you want to be notified more than once, set the time pe-
riod to a larger number. Each number corresponds to the times of notification.  
 
Action- Command: Permits you to execute command files and set a period of time to delay its acti-
vation. To enable or disable this action, mark the Enable Command check box.  
 
Action - Alarm: Permits you to send out audible alarm instead of a broadcast message. There is 
only buzzer alarm for SentryPlus on UNIX. If you want to be notified once, set the time period to "0". 
However, if you want to be notified more than once, set the time period to a larger number. Each 
number corresponds to the times of notification.  
 
Action - e-mail: Permits you to send mail. If you want to be notified once, set the time period to "0". 
However if you want to be notified more than once, set the time period to a larger number. Each 
number corresponds to the times of notification. You can edit the user list by clicking the Edit list but-
ton, and add, modify or delete any user name in the list. To enable or disable this action, mark the 
Enable e-mail check box.  
 
Action - SNMP Trap: Lets you send a SNMP trap when the relative power event occurs. To enable 
or disable this action, mark the Enable SNMP Trap check box. You also need to specify the SNMP 
Trap target hosts and community string please see the SNMP dialog box in the Network menu.  
 
Action - Receptacle Control: Permits you to control Receptacle Relay on or off. Each Receptacle 
Relay may control not only one outlet, please see the rear panel of your UPS or the UPS hardware 
user's manual.  
 
Stop All Action: Clicking on this terminates all the actions immediately. 
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External Battery Pack 
 
External Battery Pack (not all UPSs support this function):  The RS232 port MUST be used when 
configuring the UPS for External Battery Packs.  The USB port does NOT support configuring the 
UPS for External Battery Packs.  When using an External Battery Pack with the UPS, the UPS must 
be configured; to report the correct Estimated Runtime and so that the Battery Capacity Bar Graph 
LEDs on the front panel will work properly during the battery mode operation.  Simply click on Con-
figure, UPS, and then External Battery Pack.  Then select the number of External Battery Packs that 
are connected to the UPS. 
 
Advanced UPS Property 
 
If your UPS does not support this function, the item will display a grayed area and the user cannot 
select this item.  

 
Enable Wakeup Computer: If your computer’s architecture is com-
patible to ATX and the BIOS supports RS-232 (RI) Wakeup function. 
You should enable this item to make the Schedule work correctly.  
Enable Resume Computer: Be sure the BIOS supports RS-232 (RI) 
Wakeup function. When SentryPlus suspends the computer and the 
UPS detects the change of power status, UPS will resume the com-
puter and let SentryPlus notify the users.  
 
 
 
 

Enable Power Fail, Auto-Reboot: The time-line is described below: 
 
 
 
 
 
 
 
 
 
 
If you enable this function, the UPS will reboot to restart the computer. Otherwise, it will return back 
to normal state.  
 
Enable Economic Mode: Switch to UPS economic mode.  
 
UPS Periodic Auto-Test: Daily, weekly, biweekly and monthly. UPS starts the test procedure auto-
matically when it reaches the test time. 
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Network Menu 
 
Set Password:  Set the SentryPlus Service password.  
 
Choose Master/Slave: Set SentryPlus Service mode. If the computer is connected to the UPS di-
rectly (with RS-232 cable or USB cable) then the SentryPlus Service acts as a Master, otherwise it is 
a Slave. When SentryPlus Service is a Slave you must assign the Master IP address such that the 
Slave can connect to the Master host and get the UPS information.  

a. Master: Configure the SentryPlus Service to be a Master. The Master will forward the UPS in-
formation to a connected Slave(s).  

b. Slave: Configure the SentryPlus Service be a Slave.  
c. Master IP Address: When SentryPlus Service becomes a Slave you must assign the Master 

IP address such that the Slave can connect to the Master host and get the UPS information. If 
you leave the item empty or type a wrong address, SentryPlus will show a disconnect message. 

 
Remote Wakeup: To wake up the remote host, SentryPlus sends a Magic Packet through the net-
work. You must give the IP address and the network hardware address (MAC address) of the remote 
host. In Windows98, you can execute the "ipconfig /All" command under MS-DOS prompt to get the 
network card physical address of the local host. Or, input the "arp -a" command to see the remote 
host’s physical address. Your network card must support the remote wakeup feature and this func-
tion should be enabled.  

a. SentryPlus Resume The Computer From Suspend Mode: SentryPlus may force the com-
puter into suspend mode (input power failed or other power events), program will wake up the 
remote hosts that enable this item when the local host is woken.  

b. Each Time SentryPlus Startup: Program will wake up the remote hosts that enable this item 
when SentryPlus starts up and connects to the UPS.  
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SNMP 
 
Select the Accept SNMP packet from any hosts, SentryPlus will accept all the request commands 
and set commands. When you select the Accept SNMP packet from the following hosts, SentryPlus 
receives only the hosts that you assigned. Once the power event occurs and the user enables the 
SNMP Trap in the Action dialog box, SentryPlus will send the SNMP trap to the hosts that are listed 
in the Trap Target list box. To add, modify or delete the host, click on its respective command button.  
 
If the SentryPlus Service you are connecting is running on UNIX series, and Windows 95/98 
operating system, you can configure the SNMP parameters directly from the SentryPlus:  
Select the Accept SNMP packet from any hosts, SentryPlus will accept all the request commands 
and set commands. When you select the Accept SNMP packet from the following hosts, SentryPlus 
receives only the hosts that you assigned. Once the power event occurred and user enables the 
SNMP Trap in the Action dialog box, SentryPlus will send the SNMP trap to the hosts that listed in 
the Trap Target list box. To add, modify or delete the host, click on its respective command button. 
 
If the SentryPlus Service you are connecting is running on Windows NT or Windows 2000 op-
erating system, you must install the SNMP Service and configure the SNMP parameters from 
your operating system:  
SentryPlus will ignore the values that were set in the SNMP dialog box. To change the parameters of 
SNMP function, you should install the SNMP Service in the Network option. Select the SNMP Ser-
vice from the Network option in the Control Panel and click the Property button to do your changes. 
 
If the SentryPlus Service you are connecting is running on Novell NetWare operating system, 
all setting in this SNMP configuring dialog will not take any effect. Please edit the file 
SYS:\etc\Traptarg.cfg directly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
SNMP Trap Number: 



 20

 
Variable Trap 

No. 
Description 

dupsCommunicationLost 1 SEVER: Communication with the UPS failed 
dupsCommunicationEstablished 2 INFORMATION: Communication with the UPS reestablished 
dupsPowerFail 3 WARNING: Power failed! The UPS is operating on battery power 
dupsPowerRestored 4 INFORMATION: Power restored! The utility power restored 
dupsLowBattery 5 SEVER: The UPS batteries are low and will soon be exhausted 
dupsReturnFromLowBattery 6 INFORMATION: The UPS has returned from a low battery condition 
dupsLoadWarning 7 INFORMATION: Loading percent of the UPS over the Load Warning value 
dupsNoLongerLoadWarning 8 INFORMATION: Returned from Load Warning condition 
dupsLoadSeverity 9 Warning: Loading percent of the UPS over the Load Severity value 
dupsNoLongerLoadSeverity   10 INFORMATION: Returned from Load Severity condition 
dupsLoadOnBypass 11 WARNING: The UPS loads on bypass 
dupsNoLongerLoadOnBypass 12 INFORMATION: The UPS is not on bypass mode 
dupsUPSFault 13 SEVER: A general fault caused in the UPS 
dupsBatteryGroundFault 14 SEVER: The UPS battery ground fault 
dupsNoLongerBatteryFault 15 INFORMATION: The UPS recovered from battery ground fault 
dupsTestInProgress 16 INFORMATION: The UPS test in progress 
dupsBatteryTestFail 17 SEVER: The UPS test in progress 
dupsFuseFailure 18 SEVER: The UPS fuse failed 
dupsFuseRecovered 19 INFORMATION: The UPS fuse recovered 
dupsOutputOverload 20 SEVER: The UPS overload 
dupsNoLongerOverload 21 INFORMATION: Recovered from UPS overload 
dupsOutputOverCurrent 22 SEVER: The UPS output over current 
dupsNoLongerOutputOverCurrent 23 INFORMATION: Recovered from UPS over current 
dupsInverterAbnormal 24 SEVER: The UPS inverter abnormal 
dupsInverterRecovered 25 SEVER: Recovered from UPS inverter abnormal 
dupsRectifierAbnormal 26 SEVER: The UPS rectifier abnormal 
dupsRectifierRecovered  27 INFORMATION: The UPS recovered from rectifier abnormal 
dupsReserveAbnormal 28 SEVER: The UPS rectifier abnormal 
dupsReserveRecovered 29 INFORMATION: The UPS rectifier abnormal 
dupsLoadOnReserve 30 INFORMATION: The UPS load on reserve 
dupsNoLongerLoadOnReserve 31 INFORMATION: The UPS no longer load on reserve 
dupsEnvOverTemperature 32 WARNING: The environment over temperature 
DupsNoLongerEnvOverTemperature 33 INFORMATION: The environment recovered from over temperature 
DupsEnvOverHumidity 34 WARNING: The environment over humidity 
DupsNoLongerEnvOverHumidity 35 INFORMATION: The environment recovered from over humidity 

 
 
HTTP 
 
SentryPlus supports WEB Server for remote manager to get UPS information. User can use IE or 
the Communicator to connect to SentryPlus Service. Even if your computer does not install Sentry-
Plus, you can monitor and control your UPS via the network.  

a. HTTP Root: The HTTP root path.  
All the html and gif files will be located here.  

b. Port Number: Default port number is 80 but if there is already one WEB server running you 
can change SentryPlus Service HTTP port number to a different number. At the Internet 
Browser you can input http://172.16.176.141:2000 in the URL where 2000 is the assigned port 
number. 
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Control Menu 
 

Shutdown Now: This command will execute the shutdown procedure at once.  
a. Restart: This function lets you restart the OS and UPS automatically after being shutdown. To 

start the OS and UPS for the next schedule, mark the Restart check box.  
b. Shutdown OS and UPS: Use this function to shutdown both OS and UPS.  
c. SHUTDOWN OS Only: Use this function to shutdown OS only.  
d. SUSPEND OS Only: Use this function to suspend your operating system.  
e. HIBERNATE OS Only: Use this function to hibernate your operating system.  

 
Cancel Shutdown: This menu enables you to terminate the current shutdown procedure.  
 
Turn Receptacle Relay On: Turn the selected receptacle relay on. 
Each Receptacle Relay may control more than one outlet, please see the rear panel of your UPS or 
the UPS user's manual.  

a. Select a Receptacle Relay: Select a receptacle relay.  
b. Delay: Set the delay time to turn on the receptacle relay.  
c. Turn On: Execute the turn on command.  

 
Turn Receptacle Relay Off: Turn the receptacle relay off. Each Receptacle Relay may control not 
only one outlet, please see the rear panel of your UPS or the UPS user's manual.  

a. Select a Receptacle Relay: Select a receptacle relay.  
b. Delay: Set the delay time to turn off the outlet group.  
c. Turn Off: Execute the turn off command.  

 
UPS Audible Alarm On: Enable the UPS buzzer from the Bottom Layer Buttons. Press the Status 
button to get the UPS buzzer status.  
 
UPS Audible Alarm Off: Mute UPS buzzer alarm.  
 
10 Seconds Test: UPS switches to backup mode and output power is supplied by battery for 10-
seconds.  
Deep Battery Test: UPS switches to backup mode and output power is supplied by battery until Low 
Battery Warning (LBW).  
 
Cancel Test: This menu allows you to stop testing the UPS immediately. 
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View Menu 
 

Meters: The SentryPlus supports up to 12 meters to be display in real-time values. Each meter has 
the ability to display all of the UPS values. Selecting different items from the Selection dialog box will 
display the selected item value.  

a. 2,4,6,8,12: Displayed meter number.  
b. Selection: Assign each meter to differ-
ent UPS item value.  
c. Close: Close the meter window.  

 

 
 
 

 
Event Log: This menu offers you the possibility of viewing past events.  

a. Exit: Close event log dialog box.  
 
History Graph: Clicking on the History Graph opens a dialog box that contains information about 
UPS data in graph form. This information is available only if there is an accumulation of data. You 
can select the month and year you want to view. 

 
a. Horizontal Scale: Select the time scale.  
b. Vertical Scale: Select the value scale.  
c. Select Month: The UPS data in the 
month you want to see.  
d. Draw Item1 (Blue): Draw the UPS item 
value by blue line.  
e. Draw Item2 (Red): Draw the UPS item 
value by red line.  
f. Update: Update the graph.  
g. Exit: Close the history graph dialog box.  

 
 
 
 

 
History Data: Clicking on the History Data opens a dialog box that contains information about UPS data in list 
form. This information is available only if there is an accumulation of data. You can select the month and year 
you want to view.  

a. Select Month: The UPS data in the month that you want to see.  
b. Update: Update the list.  
c. Exit: Close the history data dialog box.  
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Remote Hosts: Detect the hosts which running the SentryPlus Service in the LAN. You can also type in the 
IP address and connect to the WAN.  

a. Search Result: The hosts will be listed in the Search Result list box. Select the host you want to con-
nect and press the Connect button to establish the connection.  

b. Connect to this IP address: SentryPlus will connect to the IP address that you type in.  
c. Connect: Establish the network connection. 
 

Content: This is online help.  
 
About: SentryPlus version and copyright. 
 
 
Bottom Layer Buttons 
 

 
 
 

Each button shows the respective information in the Information Area. 
Main: General Information about the UPS.  
Tree: There are 2 sub-trees in the SentryPlus tree: System and UPS. System tree for host information and 
the status of Master/Slave connection, the UPS tree for all of the UPS information.  
Time: Display the time of the schedule, battery replacement date and countdown time.  
Status: UPS status.  
Diagram: Indicate the UPS current flow.  
Scroll: UPS data graph.  
Outlet: Display outlet status. (If your UPS cannot control outlet then this button disappears)  
Network: Indicate the connection of Master/Slave, SentryPlus Monitor and SentryPlus Service. 
 

Main  
UPS Health: 3 levels: Green, yellow and red.  
UPS Type: On line, off line, line interactive or 3 phase on line.  
UPS Model: The UPS model, which is being monitored by SentryPlus.  
Firmware Version: Indicating the firmware version of the UPS. 
Host Name: The host, which runs SentryPlus.  
Rating VA: The UPS VA rating. 
Rating Input Voltage: The UPS rated input voltage.  
Rating Current: The UPS rated current.  
Rating Battery Voltage: The UPS rated battery voltage.  
Rating Input Frequency: The UPS rated input frequency.  
Test Result: The results of the last self-test performed by the UPS. 
AC Source: Normal, battery or bypass.  
Battery Status: The status of battery.  
Battery Level: Percentage of the battery level.  
Loading: Percentage of the output load.  
SentryPlus has the ability to change the display item of the meters, the referred menu item: System-> Main 
Screen. 
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Time  
Last Battery Replacement Date: To change the date of last battery replacement in the System-> 
Configuration UPS->UPS Property.  
Next Battery Replacement Date: To change the date of next battery replacement in the System-
> Configuration UPS->UPS Property.  
Next 10 seconds Test Time: System-> Configuration UPS-> Schedule.  
Next Deep Test Time: System-> Configuration UPS-> Schedule.  
Next Shutdown UPS Time: system->Configuration UPS-> Schedule.  
Next Restart UPS Time: System-> Configuration UPS-> Schedule. 
 

Status  
Show all of the UPS status, red light indicates this event happened. 
 

Diagram 
Input and output power flow of UPS. 
 

Scroll 
Record the recent UPS data information. you can change the display item from System->Main 
Screen. 
 

Network 
Display all the SentryPlus Service searched in the LAN. 
 

Outlet 
Display the UPS outlet status (If your UPS cannot control outlet this button disappeared). 
Status: Identify the current outlet status: Normal or off.  
Next Turn Off Time: System->Configuration->UPS->Schedule  
Next Turn On Time: System->Configuration->UPS->Schedule 
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Obtaining Technical Assistance 
 
For Technical Support on the Web, please visit the Support section of our Web site or visit our online Discussion Forum 
at www.minutemanups.com.  Please have the information listed below ready when you contact us.  You can reach us by 
calling:  Phone:  1-972-446-7363, Fax:  1-972-446-9011. 
In order to diagnose the problem you are having, our technicians need the following information from you. 

Installation Site: 
Company Name:             
Address:              
City:       State:   ZIP code:    

Contact Person’s Name:            
Phone Number:              

 
If you are a consultant, 
Consultant Name:             
Phone Number:       Fax Number:      

 
Computer System: 
Operating System and version:            
System Manufacturer:             
System Model Number:             
NMS name and revision number:           

 
UPS: 
Model Name/Number:             
Serial Number:              

 

What are the symptoms? 

               

               

               

               

               

 

 

 
PN: 34000292_R1.2 
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Présentation

Félicitations pour votre achat du logiciel de gestion d'arrêt SentryPlus pour gérer votre système d'alimentation 
sans interruption (UPS). L'objectif de SentryPlus est de surveiller votre onduleur et de répondre à tous vos besoins 
de gestion de l'alimentation. SentryPlus a la capacité d'arrêter correctement votre ordinateur lorsqu'une panne de 
courant prolongée se produit.

SentryPlus fournit les informations les plus utiles sur l'onduleur et toutes vos questions sur la 
gestion de l'alimentation. Nous avons ajouté le protocole de gestion de réseau le plus populaire 
(SNMP) dans SentryPlus. Pour utiliser les ressources sur Internet, SentryPlus prend également en 
charge le protocole HTTP. Cela signifie que vous pouvez surveiller votre UPS n'importe où, 
n'importe quand, simplement en utilisant le navigateur Internet.

SentryPlus s'exécute en arrière-plan comme un processus démon sur les systèmes UNIX et communique avec l'onduleur 
pour protéger votre ordinateur et votre équipement de tout problème d'alimentation. De plus, il vous fournit les 
informations les plus utiles sur votre onduleur et votre ordinateur.

Caractéristiques de SentryPlus :

1. Arrêt gracieux du système d'exploitation
2. Programmer le test, arrêter/redémarrer l'onduleur, allumer/éteindre les prises

3. Événements flexibles

4. Notification : téléavertisseur, courriel et alarme sonore, diffusion réseau et SNMP
5. Valeurs en temps réel de la tension, du courant, de la fréquence et de la charge

6. Données historiques et graphique

7. Moniteur réseau
8. Arrêt/redémarrage de plusieurs ordinateurs

9. Prise en charge du protocole de gestion de réseau simple (SNMP)

10. Support HTTP, surveillance et contrôle à distance à l'aide d'un navigateur Internet
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Installation de SentryPlus

Exigences :
1. Pour utiliser SentryPlus, votre système doit exécuter l'un des systèmes d'exploitation suivants :

Hewlett Packard HP-UX 10.0 (service SentryPlus seulement) 
IBM AIX 4.3
SCO OpenServer 5.0
SunSoft Solaris 2.5.1 pour les processeurs SPARC
RedHat Linux 5.2, Turbo Linux 4.0, SUSE Linux 6.1, Open Linux 2.3, Mandriva Linux. 
FreeBSD 2.2.8

2. SentryPlus Monitor peut fonctionner sur X11R6 ou supérieur avec 256 couleurs ou plus.

Configuration de SentryPlus :

1. Pour configurer SentryPlus, connectez-vous à votre système en tant que superviseur (root).

2. Placez le CD SentryPlus dans votre lecteur de CD-ROM et montez-le.
3. Changez le répertoire de travail en/CD-Rom/Unix/VotreUnix, où/CD-ROMest le point de montage de

votre lecteur de CD-ROM, etVousUnixest le nom de votre système Unix. Par exemple, /cdrom/Unix/
Linuxou/CD-ROM/Unix/Sun.

4. Copiez le seul fichier,VotreUnix.tar, dans votre répertoire de travail dans le répertoire /tmp.
5. Modifiez votre répertoire de travail en/tmp.
6. Tapez le fichier avec la commande :tar xvf VotreUnix.tar. Notez que certains systèmes d'exploitation peuvent nécessiter « - » avant les
arguments.

7. Courir/installer.

8. Suivez les instructions du programme d'installation.
9. Après l'installation, les fichiers du programme SentryPlus seront situés dans le répertoire/usr/local/intelligent.

Remarque : certains systèmes d’exploitation pourraient ne pas activer le port COM par défaut. Assurez-vous donc que le port COM 
connecté à l'onduleur a été activé avant d'exécuter SentryPlus.

Le logiciel SentryPlus est composé de deux modules :
Un module de surveillance UPS (service SentryPlus, nom de fichier : upsd), qui s'exécute en arrière-plan en tant 
que processus démon sur votre système et communique avec l'onduleur.
Un module d'interface utilisateur (SentryPlus Monitor, nom de fichier : monitor) qui vous permet de contrôler et de 
configurer SentryPlus via les menus déroulants et les boîtes de dialogue. Il vous permet aussi de surveiller 
l'onduleur par l'entremise de l'écran principal.
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Service SentryPlus

Le service SentryPlus, qui s'exécute en arrière-plan, est un processus démon au démarrage du système. Vous pouvez 
également exécuter le service SentryPlus manuellement en tapant la commande/usr/local/smart/upsd. Pour arrêter le 
service SentryPlus, entrez la commande/arrêt usr/local/smart/upsd.

Moniteur SentryPlus

SentryPlus Monitor vous permet de contrôler et de configurer SentryPlus via le menu déroulant et les boîtes de 
dialogue. Il vous permet aussi de surveiller l'onduleur par l'entremise de l'écran principal. SentryPlus Monitor n'a 
pas besoin de résider dans la mémoire, l'exécution dépend des besoins de l'utilisateur. Cela peut vous faire 
économiser de précieuses ressources système.

Une fois l'installation de SentryPlus terminée, le service SentryPlus se charge automatiquement en mémoire et s'exécute une 
fois le système d'exploitation démarré.

Pour exécuter SentryPlus Monitor, modifiez votre répertoire de travail en/usr/local/intelligentet tapez la 
commande/usr/local/smart/moniteur.

Écran principal du moniteur SentryPlus :
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Réseautage

Le logiciel SentryPlus comprend deux modules : SentryPlus Service et SentryPlus Monitor. Vous pouvez exécuter les 
deux programmes pour surveiller votre onduleur localisé ou exécuter les programmes sur deux ordinateurs différents.

Arrêt de plusieurs ordinateurs.

Service SentryPlus avec 2 modes : Maître et Esclave.

S'il y a un câble de communication entre l'ordinateur et un onduleur, cet ordinateur est appelé Maître. Le maître 
peut surveiller et contrôler directement l'onduleur connecté, car il transmet aussi les informations de l'onduleur 
aux esclaves.

Si un ordinateur ne se branche pas directement à l'onduleur, mais qu'il est alimenté par le même onduleur, cet ordinateur est 
appelé esclave. Le maître communique avec l'esclave par un réseau TCP/IP.

Lorsqu'un événement d'alimentation se produit, le maître (service SentryPlus) obtient les informations puis les transmet aux 
esclaves (service SentryPlus). Chaque service SentryPlus exécute différentes « actions » (FlexEvent) afin que le gestionnaire 
système puisse configurer une stratégie différente pour un ordinateur différent. Par exemple : en cas de panne de courant, le 
serveur de fichiers et le serveur de messagerie ne s'arrêtent pas tant que la batterie de l'onduleur n'est pas faible, mais 
certains postes de travail sans importance exécutent l'arrêt du système d'exploitation après 5 minutes et les autres postes de 
travail s'arrêtent après 10 minutes. Les postes de travail arrêtés préservent plus d'énergie de batterie pour les serveurs réseau.
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Surveillance et contrôle à distance

Surveillance et contrôle à distance : SentryPlus Monitor.

SentryPlus Monitor a la capacité de surveiller l'hôte local et l'hôte distant.

Vous pouvez exécuter SentryPlus Monitor sans exécuter SentryPlus Service. Cliquez sur la zone de liste 
déroulante Sélection d'hôte et elle fournira une liste des hôtes recherchés dans le LAN. Sélectionnez-en un, 
puis SentryPlus Monitor se connectera à l'hôte sélectionné. L'hôte est situé sur Internet, vous pouvez donc 
également saisir l'adresse IP de l'hôte distant à partir du menu Affichage – Hôtes distants pour établir la 
connexion.

Surveillance et contrôle à distance : navigateur Internet.

Une autre façon de surveiller à distance le service SentryPlus est d'utiliser le navigateur Internet. Lancez Microsoft Internet 
Explorer ou Netscape Communicator, tapez l'adresse IP dans l'URL et appuyez sur Entrée, vous obtiendrez les informations 
UPS. Vous pouvez modifier le numéro de port réseau pour éviter tout conflit avec d'autres programmes de serveur WEB. Si le 
numéro de port n'est pas 80, vous devez taper l'URL comme ceci : http://172.16.176.141:2000 où 2000 est le numéro de port 
que vous avez attribué. Le nom d'utilisateur et le mot de passe par défaut sont admin.
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Fonctionnement du moniteur SentryPlus

L'écran principal comporte 7 zones qui présentent des renseignements sur l'état de fonctionnement de votre onduleur. Ces 
domaines sont abordés dans les sections suivantes.

Sélection de l'hôte: Appuyez sur la zone de liste déroulante pour sélectionner les hôtes qui exécutent le service SentryPlus sur le réseau local. Les utilisateurs 

peuvent surveiller ou contrôler (mot de passe requis) l'onduleur à distance.

Indication de connexion:L'onde sinusoïdale apparaîtra lorsque la communication entre SentryPlus 
Monitor et SentryPlus Service est établie.

Affichage des renseignements:Appuyez sur les boutons de la couche inférieure pour modifier les informations affichées dans cette zone.

Journal des événements récents: Affiche les 10 derniers journaux d'événements dans la zone de liste déroulante, cliquez sur la zone de liste déroulante pour 

dérouler et voir les journaux.
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Boutons de la couche supérieure

Boutons de la couche supérieure

Utilisez ces boutons pour accélérer votre opération. Référez-vous aux boîtes de dialogue dans le menu.

Configuration:Identique au menu Système-> Configuration. Compteurs:Identique à 

Affichage-> Compteurs dans le menu. Journal des événements:Identique à Affichage-> 

Journal des événements dans le menu. Graphique historique:Identique à l'affichage-> 

Graphique historique dans le menu.

Menu principal du moniteur SentryPlus
L'écran principal comporte une barre de menu en haut avec 4 options principales :

Système:Ce menu vous permet de définir les paramètres de SentryPlus et de l'ordinateur. 

Contrôler:Ce menu vous permet de régler le buzzer, la prise et le test de l'onduleur.

Vue:Le menu Affichage vous permet de voir les valeurs en temps réel et l'historique des événements ou des données 

d'historique. Aider:Le menu Aide vous permet d'accéder au système d'aide en ligne.
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Menu système

Le menu système vous permet de configurer l'onduleur et de surveiller les paramètres de l'écran. Lorsque vous sélectionnez le 
menu Système dans la barre de menu principale, un menu déroulant s'affiche vous proposant les options de menu suivantes :

Se connecter:Utilisé pour le moniteur à distance. L'utilisateur doit passer la vérification du mot de passe avant de pouvoir contrôler ou 
configurer l'onduleur.

ConfigurationLe menu Configuration vous permet de personnaliser divers paramètres de SentryPlus. Écran de surveillance: Vous 

permet de modifier les éléments d'affichage dans l'écran de défilement de la zone d'affichage des informations.

Fenêtre:Ce menu vous permet de modifier les éléments d'affichage dans la zone d'affichage des informations. Les éléments 
du menu font référence à chaque bouton des boutons de la couche inférieure.

Fermer le moniteur: Arrêtez SentryPlus Monitor.

Se connecter

Lorsque SentryPlus Monitor devient un moniteur distant (connecté à un hôte différent), vous devez passer la vérification du 
mot de passe si vous voulez effectuer la configuration ou contrôler l'onduleur, sinon, vous ne pouvez afficher que les 
informations de l'onduleur.

Si l'utilisateur exécute SentryPlus Service et SentryPlus Monitor sur le même ordinateur, vous pouvez effectuer votre 
configuration ou contrôler l'onduleur sans mot de passe.
Pour modifier votre mot de passe, veuillez choisir Définir le mot de passe dans le menu Configurer - Réseau.

Écran de surveillance

Cette boîte de dialogue vous permet de modifier l'élément d'affichage dans l'écran de défilement de la zone d'affichage des informations.

un. Compteurs:Appuyez sur le bouton principal dans les boutons de la couche inférieure, il y 
a deux compteurs dans la zone d'informations. Vous pouvez modifier les éléments 
d'affichage des deux compteurs.

b. Fenêtre de défilement:Appuyez sur le bouton de défilement dans les boutons de la
couche inférieure, la fenêtre de défilement s'affiche dans la zone d'informations. Cet élément
vous permet de modifier l'étape et les éléments d'affichage.

Fenêtre
Ce menu vous permet de modifier les éléments d'affichage dans la zone d'affichage des informations. Les éléments du menu font 
référence à chaque bouton des boutons de la couche inférieure.

Fermer le moniteur

Fermez SentryPlus Monitor et laissez SentryPlus Service en cours d’exécution.
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Fenêtre de configuration

L'écran de configuration comporte une barre de menu en haut avec trois options principales : 
Appareils Ce menu permet de configurer le modem, le pager et le courrier électronique. 
UPS:Le menu UPS vous permet de planifier le programme UPS ou d'effectuer l'action.
Réseau Ce menu vous permet de choisir Maître/Esclave ou de configurer les fonctions SNMP, HTTP.

Fenêtre de configuration
Port de communication UPS :COM1, ... COM4. Les noms de ports sont différents selon les systèmes.

Date/heure du prochain test UPS :La date du prochain autotest UPS lancé par l'utilisateur. Paramètre du système-
> Configuration->UPS->Programme.
Date/heure de la prochaine mise hors tension de l'onduleur :Ce champ affiche la date du prochain arrêt de l'ordinateur et
de l'onduleur. Paramètre depuis Système->Configuration->UPS->Planification.

Date/heure du prochain redémarrage de l'onduleur :La date du prochain redémarrage de l'onduleur. Paramètre du système-
> Configuration->UPS->Programme.
IP de l'hôte local :Adresse IP d'un ordinateur qui exécute SentryPlus Monitor. Mode de
service SentryPlus :Le service SentryPlus agit comme un maître ou un esclave.
IP de l'hôte distant :L'hôte qui exécute le service SentryPlus. Si SentryPlus Monitor et SentryPlus Service 
s'exécutent sur le même ordinateur, ce champ sera vide.
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Menu des appareils

Appareils

ModemPour permettre à SentryPlus de vous avertir via un téléavertisseur, vous devez configurer le périphérique modem. SentryPlus 
contrôlera le périphérique modem en utilisant la commande AT par défaut.

un. Port COM :Le port de communication COM1, ...COM4.
b. Débit en bauds :Définir la vitesse de transmission des données.

c. Initialiser la chaîne :La chaîne qui est envoyée au modem avant la
tentative de pagination.
d. Préfixe de numérotation :La chaîne qui est ajoutée au début de chaque
numéro de téléavertisseur avant qu'ils ne soient envoyés au modem.

Notifications aux utilisateurs : liste des téléavertisseurs

Notifications aux utilisateurs – Liste des téléavertisseurs :Le programme composera le numéro du modem pour aviser tous les numéros 
de téléavertisseur énumérés dans la liste des téléavertisseurs. Vous pouvez entrer vous-même votre numéro de téléavertisseur. Par exemple, 
si 060123456 est votre numéro de téléavertisseur, chaque « , » indique au modem de retarder de 2 secondes, le temps de retard sert à 
attendre le signal de réponse de la commutation, puis à transmettre le numéro d'affichage 119. 119 apparaîtra sur l'écran ACL de votre 
téléavertisseur. Pour déclencher la notification du téléavertisseur, vous devez activer l'action du téléavertisseur dans la boîte de dialogue 
Action.

un. Ajouter:Ajoutez un nouveau numéro de téléavertisseur.

b. Éditer :Modifier le numéro de téléavertisseur sélectionné.

c. Supprimer:Supprimer le numéro de téléavertisseur sélectionné.
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Avis aux utilisateurs : Courriel

Notifications aux utilisateurs -- Courriel :Vous pouvez également envoyer des informations par courriel aux utilisateurs par SMTP lorsqu'un 

événement d'alimentation se produit. Le programme appelle la commande envoyer-mail pour transmettre des informations aux utilisateurs de 

messagerie attribués.

Pour déclencher la notification par courriel, vous devez activer l'action par courriel dans la boîte de dialogue Action.

un. Ajouter:Ajouter un nouvel utilisateur.

b. Éditer :Modifier le nom d'utilisateur sélectionné.

c. Supprimer:Supprimer l'utilisateur sélectionné.

d. SMTP :Configurez votre serveur SMTP pour envoyer l'e-mail.

Avis aux utilisateurs : diffusion réseau

Avis aux utilisateurs – Diffusion réseau :Vous pouvez aussi diffuser des informations aux utilisateurs lorsqu'un événement 
d'alimentation se produit. Pour déclencher la notification de diffusion, vous devez activer l'action de diffusion dans la boîte de 
dialogue Action.

un. Domaine:Activez cet élément pour diffuser tous les utilisateurs du 
domaine, sinon SentryPlus enverra des messages aux hôtes attribués 
à cet utilisateur.
b. Ajouter:Ajoutez un nouveau nom de machine.

c. Éditer :Modifier le nom de la machine sélectionnée.
d. Supprimer:Supprimer le nom sélectionné.
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Menu UPS

Propriété UPS:Cette boîte de dialogue vous permet de configurer le port COM de l'onduleur, la date 
de remplacement de la batterie, etc. L'avertissement de charge avertira l'utilisateur de réduire la 
charge de l'onduleur. La gravité de la charge arrêtera l'ordinateur pour éviter une surcharge.

un. Port COM :COM1, ...COM4.
b. Avertissement de chargement :Avertissement de charge.

c. Gravité de la charge :L'utilisateur doit réduire la charge de l'onduleur.

d. Date du dernier remplacement de la batterie :Sauvegardez la date du 

dernier remplacement de la batterie.

f. Prochaine date de remplacement de la batterie :À la date du
prochain remplacement de la batterie, SentryPlus avertira
l'utilisateur de remplacer la batterie.

f. Nom de l'hôte :Nom de l'hôte local.

Appareils connectés: Attribuer le nom de l'appareil connecté. Lorsque vous contrôlez la prise, Sentry-
Plus vous indique quels appareils vous contrôlez.

un. Sélectionnez un groupe de points de vente :Affecter un groupe de prises. Veuillez consulter le panneau arrière car 
certaines prises peuvent partager un relais de contrôle, ces prises sont appelées groupe de prises. Si vous désactivez le 
groupe de prises 1 (par exemple : prises 1 et prises 2), l'onduleur arrêtera la sortie d'alimentation vers les prises 1 et 2.

b. Nom de l'appareil :Attribuez les noms des appareils connectés, par exemple : Outlet Group1 est destiné à l’imprimante ;
Le groupe de prises 2 est pour l'ordinateur. Ces dossiers peuvent améliorer l'efficacité de votre gestion. N'oubliez pas
d'appuyer sur le bouton Mettre à jour.

c. Mise à jour:Mettez à jour votre modification.

Gestion des journaux:(Veuillez tenir compte de l'espace libre sur votre disque dur)

un. Nombre maximal d'entrées dans le journal des événements :SentryPlus enregistre moins que les entrées attribuées du journal des événements.

b. Intervalle d'enregistrement des données :Il est temps de sauvegarder un enregistrement des données UPS.

c. Stockage maximal des journaux de données :Il vous permet de sauvegarder le nombre de mois de fichiers de données UPS.
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Calendrier

Calendrier:Cette fonction vous permet d'arrêter, de redémarrer, de tester et d'allumer/éteindre la prise. Vous pouvez planifier 
jusqu'à 6 événements. Le réglage est basé sur le jour, la semaine ou le mois et jusqu'à une période de 2 ans. Choisissez 
l'horaire applicable pour définir s'il s'agit de :

un. Une fois :Cet horaire fixe est applicable pour une 
seule journée.
b. Quotidien:Cet horaire fixe s'applique tous
les jours
c. Hebdomadaire :Cet horaire fixe s'applique
une fois par semaine.
d. Mensuel :Cet horaire fixe s'applique une
fois par mois.

Action

Action:Le menu d'action vous fournit une liste d'événements parmi lesquels choisir. L'événement et/ou toute 
combinaison de ces actions peuvent être sélectionnés dans la liste Choisir un événement. Les actions déjà activées 
afficheront une coche. Pour retarder les actions, définissez le temps de retard souhaité dans la zone de liste 
déroulante Retard.

un. Choisissez l'événement :Lorsque vous sélectionnez un élément dans la liste, 

les boutons d’action affichent le paramètre actuel. Appuyez sur le bouton pour 

effectuer une configuration supplémentaire.

b. Définir par défaut :Définissez toutes les actions sur les valeurs par défaut.

c. Délai:L'événement d'alimentation doit respecter le délai de retard pour 

déclencher des actions.
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Toutes les actions sont décrites comme suit :

Action - Arrêt: Arrêter/mettre en veille prolongée/suspendre le système d'exploitation ou arrêter l'onduleur. Les fonctions Hibernate/
Suspend ne sont disponibles que sur MS Windows. Si vous sélectionnez l'élément d'arrêt, SentryPlus exécutera ou ignorera la fonction 
d'enregistrement automatique en fonction de votre sélection (dans la boîte de dialogue Action). Mais si vous sélectionnez l’élément 
suspendre ou mettre en veille prolongée ; le programme ignorera la fonction de sauvegarde automatique. Les fonctions d'arrêt, de 
mise en veille prolongée ou de suspension sont les mêmes que si vous sélectionnez Arrêter dans le menu Démarrer de Windows.

Action - Journalisation: Vous permet d'enregistrer l'événement ainsi que de modifier le message de journalisation par défaut. Vous pouvez voir ce 

message dans la boîte de dialogue Journal des événements.

Action - Diffusion:Vous permet de diffuser un événement en fonction d'une période de temps définie. Si vous 
souhaitez être averti une fois, définissez la période sur « 0 ». Toutefois, si vous voulez être averti plus d'une fois, 
définissez la période sur un nombre plus grand. Chaque numéro correspond aux heures de notification.

Action - PaginationVous permet de définir la durée des intervalles de pagination. Si vous souhaitez être averti 
une fois, définissez la période sur « 0 ». Toutefois, si vous voulez être averti plus d'une fois, définissez la période 
sur un nombre plus grand. Chaque numéro correspond aux heures de notification.

Action - Commande: Vous permet d'exécuter des fichiers de commande et de définir une période de temps pour retarder leur 
activation. Pour activer ou désactiver cette action, cochez la case Activer la commande.

Action - Alarm: Vous permet d'envoyer une alarme sonore plutôt qu'un message de diffusion. Il n'y a qu'une 
alarme sonore pour SentryPlus sous UNIX. Si vous souhaitez être averti une fois, définissez la période sur « 0 ». 
Toutefois, si vous voulez être averti plus d'une fois, définissez la période sur un nombre plus grand. Chaque 
numéro correspond aux heures de notification.

Action - Courriel: Vous permet d'envoyer du courrier. Si vous souhaitez être averti une fois, définissez la période sur « 0 ». Toutefois, si 
vous voulez être averti plus d'une fois, définissez la période sur un nombre plus grand. Chaque numéro correspond aux heures de 
notification. Vous pouvez modifier la liste des utilisateurs en cliquant sur le bouton Modifier la liste et ajouter, modifier ou supprimer 
n'importe quel nom d'utilisateur dans la liste. Pour activer ou désactiver cette action, cochez la case Activer le courrier électronique.

Action - Interruption SNMP: Vous permet d'envoyer une interruption SNMP lorsque l'événement 
d'alimentation relatif se produit. Pour activer ou désactiver cette action, cochez la case Activer le piège 
SNMP. Vous devez également spécifier les hôtes cibles du piège SNMP et la chaîne de communauté.

Action - Contrôle de la prise: Vous permet de contrôler le relais de prise activé ou désactivé. Chaque relais de prise peut 
contrôler non seulement une prise, veuillez consulter le panneau arrière de votre onduleur ou le manuel d'utilisation du 
matériel de l'onduleur.

Arrêtez toute action :Cliquer dessus met immédiatement fin à toutes les actions.
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Pack de batterie externe

Pack de batterie externe(tous les onduleurs ne prennent pas en charge cette fonction) : Le port RS232 INCONTOURNABLE 
être utilisé lors de la configuration de l'onduleur pour les ensembles de batteries externes. Le port USB ne PAS prend en charge 
la configuration de l'onduleur pour les batteries externes. Lorsque vous utilisez une batterie externe avec l'onduleur, 
l'onduleur doit être configuré ; pour signaler l'autonomie estimée correcte et pour que les DEL du graphique à barres de 
capacité de la batterie sur le panneau avant fonctionnent correctement pendant le fonctionnement en mode batterie. Cliquez 
simplement sur Configurer, UPS, puis sur Ensemble de batterie externe. Sélectionnez ensuite le nombre de blocs-piles externes 
connectés à l’onduleur.

Propriété UPS avancée

Si votre onduleur ne prend pas en charge cette fonction, l’élément affichera une zone grisée et l’utilisateur ne pourra pas sélectionner 
cet élément.

Activer le réveil de l'ordinateur :Si l'architecture de votre ordinateur est 
compatible ATX et que le BIOS prend en charge la fonction de réveil RS-232 (RI). 
Vous devez activer cet élément pour que la planification fonctionne correctement.
Activer la reprise de l'ordinateur :Assurez-vous que le BIOS prend en charge la 
fonction de réveil RS-232 (RI). Lorsque SentryPlus suspend l'ordinateur et que 
l'onduleur détecte le changement d'état d'alimentation, l'onduleur reprend 
l'ordinateur et laisse SentryPlus avertir les utilisateurs.

Activer la panne de courant et le redémarrage automatique :La chronologie est décrite ci-dessous :

Si vous activez cette fonction, l'onduleur redémarrera pour redémarrer l'ordinateur. Sinon, il reviendra à 
l'état normal.

Activer le mode économique :Passez en mode économique UPS.

Essai périodique automatique de l'onduleur :Quotidien, hebdomadaire, bimensuel et mensuel. L'onduleur démarre automatiquement la 
procédure de test lorsqu'il atteint l'heure du test.
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Menu réseau

Définir le mot de passe :Définissez le mot de passe du service SentryPlus.

Choisissez Maître/Esclave :Définir le mode de service SentryPlus. Si l'ordinateur est connecté directement à l'onduleur 
(avec un câble RS-232 ou un câble USB), le service SentryPlus agit comme un maître, sinon il est un esclave. Lorsque le 
service SentryPlus est un esclave, vous devez attribuer l'adresse IP du maître afin que l'esclave puisse se connecter à 
l'hôte maître et obtenir les informations de l'onduleur.

un. Maître:Configurez le service SentryPlus pour qu'il soit un maître. Le maître transmettra les informations de l'onduleur à 
un ou plusieurs esclaves connectés.

b. Esclave:Configurez le service SentryPlus comme esclave.
c. Adresse IP principale :Lorsque SentryPlus Service devient un esclave, vous devez attribuer l'adresse IP du maître

afin que l'esclave puisse se connecter à l'hôte maître et obtenir les informations de l'onduleur. Si vous laissez
l'élément vide ou entrez une adresse erronée, SentryPlus affichera un message de déconnexion.

Réveil à distance :Pour réveiller l'hôte distant, SentryPlus envoie un paquet magique par le réseau. Vous 
devez fournir l'adresse IP et l'adresse matérielle réseau (adresse MAC) de l'hôte distant. Sous Windows 98, 
vous pouvez exécuter la commande « ipconfig /All » sous l'invite MS-DOS pour obtenir l'adresse physique de 
la carte réseau de l'hôte local. Ou, entrez la commande « arp -a » pour voir l'adresse physique de l'hôte 
distant. Votre carte réseau doit prendre en charge la fonction de réveil à distance et cette fonction doit être 
activée.

un. SentryPlus fait sortir l'ordinateur du mode veille :SentryPlus peut forcer l'ordinateur à passer en mode 
veille (coupure d'alimentation ou autres événements d'alimentation), le programme réveillera les hôtes 
distants qui activent cet élément lorsque l'hôte local est réveillé.

b. À chaque démarrage de SentryPlus :Le programme réveillera les hôtes distants qui activent cet élément
lorsque SentryPlus démarre et se connecte à l'onduleur.
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SNMP

Sélectionnez Accepter le paquet SNMP de n'importe quel hôte, SentryPlus acceptera toutes les commandes de demande et 
définira les commandes. Lorsque vous sélectionnez Accepter le paquet SNMP des hôtes suivants, SentryPlus reçoit uniquement 
les hôtes que vous avez attribués. Une fois que l'événement d'alimentation se produit et que l'utilisateur active l'interruption 
SNMP dans la boîte de dialogue Action, SentryPlus enverra l'interruption SNMP aux hôtes répertoriés dans la zone de liste Cible 
de l'interruption. Pour ajouter, modifier ou supprimer l'hôte, cliquez sur son bouton de commande respectif.

Si le service SentryPlus auquel vous vous connectez s'exécute sur la série UNIX et sur le système d'exploitation 
Windows 95/98, vous pouvez configurer les paramètres SNMP directement depuis SentryPlus :
Sélectionnez Accepter le paquet SNMP de n'importe quel hôte, SentryPlus acceptera toutes les commandes de demande et 
définira les commandes. Lorsque vous sélectionnez Accepter le paquet SNMP des hôtes suivants, SentryPlus reçoit uniquement 
les hôtes que vous avez attribués. Une fois l'événement d'alimentation survenu et l'utilisateur ayant activé l'interruption SNMP 
dans la boîte de dialogue Action, SentryPlus enverra l'interruption SNMP aux hôtes répertoriés dans la zone de liste Cible de 
l'interruption. Pour ajouter, modifier ou supprimer l'hôte, cliquez sur son bouton de commande respectif.

Si le service SentryPlus auquel vous vous connectez s'exécute sur un système d'exploitation Windows NT ou 
Windows 2000, vous devez installer le service SNMP et configurer les paramètres SNMP à partir de votre système 
d'exploitation :
SentryPlus ignorera les valeurs définies dans la boîte de dialogue SNMP. Pour modifier les paramètres de la 
fonction SNMP, vous devez installer le service SNMP dans l'option Réseau. Sélectionnez le service SNMP dans 
l’option Réseau du Panneau de configuration et cliquez sur le bouton Propriété pour apporter vos modifications.

Si le service SentryPlus auquel vous vous connectez s'exécute sur le système d'exploitation Novell NetWare, tous les 
paramètres de cette boîte de dialogue de configuration SNMP n'auront aucun effet. Veuillez modifier directement le 
fichier SYS:\etc\Traptarg.cfg.

Numéro d'interruption SNMP :
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Variable Piège
Non.

Description

dupsCommunicationPerdu 1 GRAVE : La communication avec l'onduleur a échoué
dupsCommunicationÉtabli 2 INFORMATION : Communication avec l'onduleur rétabli
dupsPowerFail 3 ATTENTION : Panne de courant ! L'onduleur fonctionne sur batterie
dupsPowerRestored 4 INFORMATION : Courant rétabli ! Le courant électrique est rétabli
dupsLowBattery 5 GRAVE : Les batteries de l'onduleur sont faibles et seront bientôt épuisées
dupsRetourDeBatterieFaible 6 INFORMATION : L'onduleur est revenu d'un état de batterie faible
Avertissement de chargement dups 7 INFORMATIONS : Pourcentage de charge de l'onduleur au-dessus de la valeur d'avertissement de charge

Avertissement de chargement sans dups 8 INFORMATIONS : retourné depuis la condition d'avertissement de chargement

dupsLoadSeverity 9 Avertissement : Pourcentage de charge de l'onduleur supérieur à la gravité de la charge

dupsNoLongerLoadSeverity 10 RENSEIGNEMENTS : retourné à partir de la condition de gravité de la charge

dupsLoadOnBypass 11 AVERTISSEMENT : L'onduleur se charge en dérivation

dupsNoLongerLoadOnBypass 12 INFORMATION : L'onduleur n'est pas en mode dérivation
dupsUPSFault 13 GRAVE : Défaut général causé dans l'onduleur
dupsBatteryGroundFault 14 GRAVE : Défaut de masse de la batterie de l'onduleur

dupsNoLongerBatteryFault 15 INFORMATIONS : L'onduleur a récupéré d'un défaut de mise à la terre de la batterie

dupsTestEnProgrès 16 INFORMATION : Le test de l'onduleur en cours
dupsBatteryTestFail 17 SEVER : Le test UPS en cours
dupsFuseFuseFuse 18 GRAVE : Le fusible de l'onduleur est tombé en panne

dupsFuseRécupéré 19 INFORMATION : Le fusible de l'onduleur récupéré
dupsOutputOverload 20 SEVER : Surcharge de l'onduleur
dupsNoLongerOverload 21 INFORMATION : Récupération après surcharge de l'onduleur
dupsOutputOverCurrent 22 SEVER : La sortie de l'onduleur est surintensité
dupsNoLongerOutputOverCurrent 23 RENSEIGNEMENTS : Récupéré après surintensité UPS
dupsInverterAnormal 24 GRAVE : L'onduleur de l'onduleur est anormal
dupsInverterRécupéré 25 GRAVE : Récupération d'un onduleur anormal
dupsRectifierAnormal 26 GRAVE : Le redresseur de l'onduleur est anormal

dupsRectifierRecovered 27 INFORMATION : L'onduleur est revenu d'un redresseur anormal
dupsRéserveAnormal 28 GRAVE : Le redresseur de l'onduleur est anormal

dupsRéserveRécupéré 29 INFORMATION : Le redresseur de l'onduleur est anormal
dupsLoadOnReserve 30 INFORMATION : L'onduleur charge en réserve
dupsNoLongerLoadOnReserve 31 INFORMATION : L'onduleur ne charge plus en réserve
dupsEnvOverTemperature 32 AVERTISSEMENT : L'environnement surchauffe
DupsNoLongerEnvOverTemperature 33 INFORMATION : L'environnement s'est rétabli après une surchauffe
DupsEnvOverHumidity 34 AVERTISSEMENT : L'environnement est trop humide
DupsNoLongerEnvOverHumidity 35 INFORMATION : L'environnement s'est remis de l'excès d'humidité

HTTP

SentryPlus prend en charge le serveur WEB pour que le gestionnaire distant puisse obtenir des informations UPS. L'utilisateur 
peut utiliser IE ou Communicator pour se connecter au service SentryPlus. Même si votre ordinateur n'installe pas Sentry-Plus, 
vous pouvez surveiller et contrôler votre onduleur par le réseau.

un. Racine HTTP :Le chemin racine HTTP.
Tous les fichiers HTML et GIF seront situés ici.

b. Numéro de port :Le numéro de port par défaut est 80, mais si un serveur WEB est déjà en cours d'exécution,
vous pouvez modifier le numéro de port HTTP du service SentryPlus par un numéro différent. Dans le navigateur
Internet, vous pouvez saisir http://172.16.176.141:2000 dans l'URL où 2000 est le numéro de port attribué.
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Menu de contrôle

Arrêtez tout de suite :Cette commande exécutera immédiatement la procédure d'arrêt.

un. Redémarrage :Cette fonction vous permet de redémarrer automatiquement le système d'exploitation et l'onduleur après un arrêt. Pour 

démarrer le système d'exploitation et l'onduleur pour la planification suivante, cochez la case Redémarrer.

b. Arrêter le système d'exploitation et l'onduleur :Utilisez cette fonction pour arrêter à la fois le système d'exploitation et l'onduleur.

c. ARRÊT DU SYSTÈME D'EXPLOITATION SEULEMENT :Utilisez cette fonction pour arrêter seulement le système d'exploitation.

d. SUSPENDER LE SYSTÈME D'EXPLOITATION SEULEMENT :Utilisez cette fonction pour suspendre votre système d'exploitation.

f. HIBERNATE OS seulement :Utilisez cette fonction pour mettre en veille votre système d'exploitation.

Annuler l'arrêt :Ce menu vous permet de terminer la procédure d'arrêt en cours.

Activer le relais de la prise :Activez le relais de prise sélectionné.
Chaque relais de prise peut contrôler plusieurs prises, veuillez consulter le panneau arrière de votre onduleur ou le manuel 
d'utilisation de l'onduleur.

un. Sélectionnez un relais de prise :Sélectionnez un relais de prise.

b. Délai:Réglez le délai de temporisation pour activer le relais de la prise.

c. Allumer :Exécutez la commande d'activation.

Désactiver le relais de la prise :Désactivez le relais de prise. Chaque relais de prise peut contrôler non seulement une prise, 
veuillez consulter le panneau arrière de votre onduleur ou le manuel d'utilisation de l'onduleur.

un. Sélectionnez un relais de prise :Sélectionnez un relais de prise.

b. Délai:Réglez le délai de temporisation pour éteindre le groupe de prises.

c. Éteindre :Exécutez la commande d'arrêt.

Alarme sonore UPS activée :Activez le buzzer de l'onduleur à partir des boutons de la couche inférieure. Appuyez sur le bouton État 
pour obtenir l'état du buzzer de l'onduleur.

Alarme sonore UPS désactivée :Désactiver l'alarme sonore de l'onduleur.

Test de 10 secondes :L'onduleur passe en mode de secours et l'alimentation de sortie est fournie par la batterie pendant 10 
secondes.

Essai approfondi de batterie :L'onduleur passe en mode de secours et la puissance de sortie est fournie par la batterie jusqu'à 
l'avertissement de batterie faible (LBW).

Annuler le test :Ce menu vous permet d'arrêter immédiatement le test de l'onduleur.
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Voir le menu

Mètres :Le SentryPlus prend en charge jusqu'à 12 compteurs pour afficher des valeurs en temps réel. Chaque compteur a la capacité 
d'afficher toutes les valeurs de l'onduleur. La sélection de différents éléments dans la boîte de dialogue Sélection affichera la valeur de 
l'élément sélectionné.

un. 2, 4, 6, 8, 12 :Numéro de compteur affiché.

b. Sélection :Affectez chaque compteur à une valeur
d'élément UPS différente.

c. Fermer:Fermez la fenêtre du compteur.

Journal des événements :Ce menu vous offre la possibilité de visualiser les événements passés.

un. Sortie:Fermer la boîte de dialogue du journal des événements.

Graphique historique :Cliquer sur le graphique de l'historique ouvre une boîte de dialogue contenant des informations sur les 
données UPS sous forme de graphique. Ces renseignements ne sont disponibles que s'il y a une accumulation de données. Vous 
pouvez choisir le mois et l'année que vous voulez afficher.

un. Échelle horizontale :Sélectionnez l'échelle de temps.

b. Échelle verticale :Sélectionnez l'échelle de valeurs.

c. Sélectionnez le mois :Les données UPS du mois
que vous voulez voir.
d. Dessiner l'élément 1 (bleu) :Tracez la valeur de l'article UPS
par une ligne bleue.

f. Dessiner l'élément 2 (rouge) :Tracez la valeur de l'article
UPS par une ligne rouge.

f. Mise à jour:Mettre à jour le graphique.

g. Sortie:Fermer la boîte de dialogue du graphique d’historique.

Données historiques :Cliquer sur Données d'historique ouvre une boîte de dialogue contenant des informations sur les données UPS sous 
forme de liste. Ces renseignements ne sont disponibles que s'il y a une accumulation de données. Vous pouvez choisir le mois et l'année que 
vous voulez afficher.

un. Sélectionnez le mois :Les données UPS du mois que vous voulez voir.
b. Mise à jour:Mettre à jour la liste.

c. Sortie:Fermez la boîte de dialogue des données d’historique.
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Hôtes distants :Détectez les hôtes qui exécutent le service SentryPlus sur le réseau local. Vous pouvez aussi entrer 
l'adresse IP et vous connecter au WAN.

un. Résultats de la recherche :Les hôtes seront répertoriés dans la zone de liste des résultats de la recherche. Sélectionnez l'hôte auquel vous souhaitez vous 

connecter et appuyez sur le bouton Connecter pour établir la connexion.

b. Connectez-vous à cette adresse IP :SentryPlus se connectera à l'adresse IP que vous saisissez.
c. Connecter:Établir la connexion réseau.

Contenu:Ceci est une aide en ligne.

À propos de:Version et droits d'auteur de SentryPlus.

Boutons de la couche inférieure

Chaque bouton affiche les informations respectives dans la zone d'informations.
Principal:Renseignements généraux sur l'UPS.
Arbre:Il y a 2 sous-arborescences dans l'arborescence SentryPlus : Système et UPS. Arborescence système pour les informations de l'hôte 
et l'état de la connexion maître/esclave, l'arborescence UPS pour toutes les informations UPS.

Temps:Affiche l'heure de l'horaire, la date de remplacement de la batterie et le compte à rebours. 
Statut:Statut UPS.
Diagramme :Indique le débit de courant de l'onduleur. 

Rouleau :Graphique de données UPS.

Point de vente:Afficher l'état de la prise. (Si votre onduleur ne peut pas contrôler la prise, ce bouton 
disparaît) Réseau:Indiquez la connexion du maître/esclave, du moniteur SentryPlus et du service SentryPlus.

Principal
UPS Santé :3 niveaux : Vert, jaune et rouge.
Type d'onduleur :En ligne, hors ligne, en ligne interactive ou triphasé en ligne. 
Modèle d'onduleur :Le modèle UPS, surveillé par SentryPlus. 

Version du 
micrologiciel :Indique la version du micrologiciel de l'onduleur. 

Nom de l'hôte :L'hôte qui exécute SentryPlus. 

Évaluation VA :La cote VA de l'UPS.

Tension d'entrée nominale :La tension d'entrée nominale de l'onduleur. 

Évaluation actuelle :Le courant nominal de l'onduleur.

Tension nominale de la batterie :La tension nominale de la batterie de l'onduleur. 

Fréquence d'entrée nominale :La fréquence d'entrée nominale de l'onduleur. 

Résultat du test :Les résultats du dernier autotest effectué par l'onduleur. 

Source AC :Normal, batterie ou bypass. 

État de la batterie :L'état de la batterie. 

Niveau de batterie :Pourcentage du niveau de la batterie. 

Chargement :Pourcentage de la charge de sortie. SentryPlus a la possibilité de modifier l'élément d'affichage des compteurs, l'élément de menu référencé : Système -> 

Écran principal.
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Temps

Date du dernier remplacement de la batterie :Pour modifier la date du dernier remplacement de la batterie dans 
Système-> Configuration UPS-> Propriété UPS.

Prochaine date de remplacement de la batterie :Pour modifier la date du prochain remplacement de la batterie dans le système-
> Configuration UPS->Propriété UPS.
Durée du test des 10 prochaines secondes :Système -> Configuration UPS -> Programmation. Heure du 

prochain test approfondi :Système -> Configuration UPS -> Programmation. Heure de la prochaine mise 

hors tension de l'onduleur :système->Configuration UPS->Planification. Heure du prochain redémarrage 

de l'onduleur :Système -> Configuration UPS -> Programmation.

Statut
Affiche tous les états de l'onduleur, le voyant rouge indique que cet événement s'est produit.

Diagramme

Flux de puissance d'entrée et de sortie de l'onduleur.

Rouleau

Sauvegardez les informations de données UPS récentes. vous pouvez modifier l'élément d'affichage à partir de Système->Écran 
principal.

Réseau
Affiche tous les services SentryPlus recherchés dans le LAN.

Point de vente

Afficher l'état de la prise de l'onduleur (si votre onduleur ne peut pas contrôler la prise, ce bouton a disparu). Statut:

Identifiez l’état actuel de la prise : normal ou éteint. Prochaine heure d'arrêt :Système->Configuration->Onduleur-

>Programme Prochaine heure de mise en marche :Système->Configuration->Onduleur->Programme
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Obtenir du soutien technique

Pour obtenir de l'aide technique sur le Web, veuillez visiter la section Assistance de notre site Web ou visitez notre forum de discussion en ligne à l'adresse
www.minutemanups.com . Veuillez avoir les renseignements ci-dessous à portée de la main lorsque vous nous contactez. Vous pouvez nous joindre en appelant : 
Téléphone : 1-972-446-7363, Télécopieur : 1-972-446-9011.

Afin de diagnostiquer le problème que vous rencontrez, nos techniciens ont besoin des renseignements suivants de votre part. Lieu 

d'installation :

Nom de l'entreprise :

Discours:

Ville:

Nom de la personne-ressource :

Numéro de téléphone :

État: Code postal :

Si vous êtes un consultant, 

Nom du consultant :

Numéro de téléphone : Numéro de télécopieur :

Système informatique :

Système d'exploitation et version : 

Fabricant du système :

Numéro de modèle du système :

Nom et numéro de révision du NMS :

UPS :

Nom/numéro du modèle :

Numéro de série :

Quels sont les symptômes ?

Réf. : 34000292_R1.2
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